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Introduction to the Bilko for Windows 2.0
image processing software
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INTRODUCTION TO BILKO FOR WINDOWS 2.0
IMAGE PROCESSING SOFTWARE

Aim of Introduction

To introduce the basic concepts of digital image analysis and to demonstrate a series of operations by
which particular features of a digital image may be enhanced.

Objectives

After completing the lessons in this introduction, you should have learned to:

1) run the Bilko for Windows software and load digital images for analysis;

2) select and apply the image analysis and image modification routines of the Bilko for
Windows system;

3) call for Help files when in doubt about any image handling procedure.

The Introduction is split into five parts and is primarily based around the study of near infra-red
(EIRE2.BMP) and thermal infra-red (EIRE4.BMP) images of an area including north-east Ireland and
south-west Scotland taken by the AVHRR (Advance Very High Resolution Radiometer) sensor. A
Landsat Thematic Mapper and a CASI (Compact Airborne Spectrographic Imager) airborne digital
image are also utilised in the fifth part. Part1 introduces the user to using the on-line Help provided in
Bilko for Windows and then takes the student through the process of opening and displaying an image
file. Finally it asks the student to explore the image using the image cursor to introduce the concept of a
digital image. Part 2 continues this exploration using histograms and then introduces the concepts of
contrast stretching to improve the way an image is displayed. Part 3 tackles the more difficult concept
of colour and the creation of palettes to aid image display, briefly looks at how one can magnify (zoom
in) on an image, and then introduces the exploration of images by means of transects. Part 4 introduces
some of the more sophisticated procedures available in Bilko for Windows. It explores how multiple
images may be operated on and combined using user-defined formulae or predefined functions (e.g.
Normalised Difference Vegetation Index), production of scattergrams, radiometric masking, and the use
of predefined or user-constructed filters to emphasise different features in an image. Part 5 introduces
the new features which have been added to the software since v. 1.0 and is primarily for advanced users
who have mastered the basics. Allow at least 4½ hours to complete the Introduction; some students can
complete in 3½ hours but very thorough ones may take up to 5½ hours. Guidetimes (average times) and
typical range of times taken to complete each Part are given below.

Contents

Part 1 (Guidetime: 60 minutes - allow 45-70 minutes)
1. Using Bilko Help.
2. Opening and displaying an image
3. Using the image cursor

Part 2 (Guidetime: 65 minutes - allow 50-85 minutes)
4. Histograms
5. Stretches

Part 3 (Guidetime: 70 minutes - allow 55-95 minutes)
6. Palettes
7. View menu
8. Transects
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Part 4 (Guidetime: 65 minutes - allow 40-90 minutes)
9. Image menu
10. Formula documents
11. Scattergrams
12. Filters

Part 5 (Guidetime: 40 minutes - allow 20-50 minutes)
13. Image file formats
14. Using UTM coordinates
15. Making colour composites
16. More on Formula documents

Background Information and Notational Conventions

Bilko for Windows is an image processing system developed for use with worksheets and lessons in
coastal management and oceanographic applications of remote sensing.  Its routines may be applied to
the analysis of any image in an appropriate format and include many standard image processing
functions.  It has been designed to run on a Personal Computer (PC), running Microsoft Windows 3.1,
Windows 95, Windows NT 4.0 or later. It is optimised to help students learn the techniques of remote
sensing. It is assumed that potential users of Bilko for Windows are familiar with the Windows
environment and how to use a ‘mouse’.

Note: This introduction is based on using Bilko with Windows 3.1 but, apart from differences in
the way the screen looks with Windows 95 or Windows NT as the operating system, it will work
equally well with these later versions of Microsoft Windows.

In this series of introductory lessons you are required to deal with file names and to make entries on the
keyboard of your computer.  So as to be explicit about how entries should be made the following
typographic convention is used throughout the tutorial.

Keynames

In this document the names of keys are written as follows: <ESC> for the Escape key, <ENTER> for the
Enter or Return key, <CTRL> for the Control key, <SPACEBAR> for the Spacebar, <SHIFT> for the
Shift key, <ALT> for the Alternate key) and appear in small capital letters.  On your own keyboard the
key caps may abbreviate the names or represent them a little differently (e.g. the <ENTER> key may be

labelled as ↵).

Direction Keys

The direction keys are the four arrow keys (↑ ↓ → ← ) on your computer's keypad. The name of the
individual direction key refers to the direction the arrow points: the <UP> key, the <DOWN> key, the
<RIGHT> key, or the <LEFT> key.  Pairs of keys are sometimes denoted the <VERTICAL> keys (↑ ↓)
and the <HORIZONTAL> keys (← →).  You use the direction keys to move the selection, the pointer, or
the insertion point on your screen.

Combinations of keys and key sequences

A plus sign (+) between key names to press and hold down the first key while you press the second key.
For example, “press <ALT>+F” means to press and hold down the <ALT> key and press the F key, and
then release both keys.

A comma (,) between key names means to press and release the keys one after the other. For example,
“press <ALT>, V” means to press and release the <ALT> key, and then press and release the V key.
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Filenames and directory names

Names of files and directories are typed in all capitals.  For example, if you are asked to perform some
operation on a file called MYVUE.BMP, what you actually type is shown in capitals: MYVUE.BMP.
(In practice it does not matter whether you type the letters in capitals or not).
Menu Choice

In Bilko for Windows most entries are made by choosing an item from a menu.  The convention
adopted here is that menu items are shown in Arial font bold face type as, for example, File and Help.
Commonly used choices have toolbar buttons assigned to them. They can also be invoked by pressing
<ALT> + the underlined letter in the menu item.

Startup

To begin the introductory guide you must load and run the Bilko for Windows control program
(WINBILKO.EXE). To do this you must have Windows 3.1 or later (e.g. Windows 95 or Windows NT)
running.

Activity: Double-click on the Bilko icon in the appropriate window of the Program
Manager (Windows 3.1) or Start the program as appropriate (later versions
of Windows) and the following window will appear. Maximise the UNESCO
BILKO application window to fill the whole screen.

The Main Bilko for Windows Menu

You have three options in the menu bar: File, View and Help. We will discuss using Help first as this
is particularly useful when you are starting to use Bilko for Windows and are unfamiliar with its
capabilities.

1. Using Bilko Help

Before you do anything else you ought
to familiarise yourself with the Help
system. Click on Help and the drop-
down menu gives you two useful
options: Index and Using Help. If
you are unfamiliar with the Windows
type of Help systems then you should
select Using Help and browse through the information provided.
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When you select Index and you will see a screen with the following text:

BILKO Help Index

To choose a topic, press Tab to select the underlined topic you want to view, and then press Enter.
With the mouse, point to the underlined topic you want to view, and then click the mouse button.
Scroll down to see more topics.  For more information on using Help, press F1. To return to this topic,
choose the Index button.

How to use BILKO

Basic Concepts
Document Types
Importing and Exporting
Managing Files

Reference

Commands
Definitions
Dialog Boxes
Keyboard and Mouse

If you move the mouse pointer over topics in the Help windows which are underlined and normally in
green, the pointer will change from an arrow into a hand. If you now click the left-button of the mouse
you will get information on that topic.

The information in the Bilko for Windows Help screens gives guidance on all aspects of how to use the
image processing software. You should consult Help regularly whilst going through this Introduction.
The quick key to access help is the F1 function key.

Activity: If you are not already in Bilko’s Help window then either select Help then Index from the
menu bar with the mouse or press the F1 key. Now take some time to explore the Basic
Concepts section of the How to use BILKO. This will be time well spent.

Use of the two buttons to the right of the toolbar

Clicking the first of these two buttons on the toolbar brings up a window entitled About
UNESCO BILKO which contains information on your computer such as the amount of
memory and diskspace available. The second (context sensitive Help) button may be used to

make specific Help queries about menu items, other toolbar buttons or the Bilko environment.

Activity: Click on the context sensitive Help button. The mouse pointer changes to an arrow and
question mark and now looks like the button. Move the pointer to File on the menu bar and
press the left mouse button whilst dragging the highlight until it is over Open. Now
release the mouse button and help information appears on the Open command (File
menu). A task you will frequently need to do is to open an Image Document file. To find
out how you might do this, move the mouse pointer over File Open dialog box and
click to get more information about this item. Note that there are eight main types of files
or ‘document types’ that can be opened.

1. IMAGE Document
2. FILTER Document
3. HISTOGRAM Document
4. PALETTE Document

5. STRETCH Document
6. TRANSECT Document
7. FORMULA Document
8. SCATTER Document
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When you have read the help information, click on the Contents button to get back to the
main index and then select Document Types to find out more about these file types.
They are central to how Bilko for Windows works so it is important you understand a bit
about them.

If you are unclear about using Help refer to the box below for basic guidance.

Contents: Whenever you choose this option you will return to the initial list of contents.

Search: Allows you to search for help on a particular topic. When you click on the Search button, a
dialog box appears. You can either select a keyword from the list provided or you can type in your
search keyword in the top box where the cursor will be. The search will look for the nearest fit if the
text you have entered is not found. Once you have selected a keyword from the list or typed in the
subject on which you need more information, use the mouse to click on the Show Topics button. In
many cases there may only be Help information on one topic for a keyword but in other cases there may
be information on several topics relating to one keyword. Click on the topic in which you are interested
and then click the Go To button to access the information on that topic.

Back: will return you to the last topic you viewed. If you repeat Back you will eventually return to the
Contents page.

History: gives a list of the headings you have investigated with Help and may be used to see what you
have covered during the current session.

<< and >>: when activated are the backward and forward browse buttons that move you systematically
through a series of related Help topics.

Question 1: Based on your exploration of the Document Types part of the online Help, answer the
following questions.

1.1: Where is the default origin of an Image document and what are its (row and column)
coordinates?

1.2: What does the data in a Stretch document relate to?

1.3: What information do Histogram documents contain and how is this represented?
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2. Opening and displaying an image

To make use of the Bilko for Windows software it is necessary to provide an image on which to perform
the available operations. Bilko for Windows works with various types of ‘documents’ (files) as was
noted above. If you are on a computer network find out where images, palettes, stretches and other
documents used by Bilko for Windows are stored in case you need to tell the program software where to
find them.

Activity: Click on the File menu: note that the names of the four
most recently used filenames are indicated on the menu (see
right). Then click on Open. This brings up the File Open
dialog box which will initially be looking to list files of the
IMAGES document type, since nothing useful can be done
until an image is loaded. [Note: make sure the Extract and
Apply check boxes are checked (have a 4or 6 in them,
depending on your version of Windows)].

Images may be stored in a number of formats which are denoted by the
various file extensions in parentheses after IMAGES in the List Files
of Type: box (see below).

Activity: The file you will work with first is called EIRE4.BMP. If this is listed in the File Name:
list box, double-click on it to open and display it.

If necessary:

Either use the Drives: and Directories: boxes to tell Bilko for Windows where the
images are stored and then click on EIRE4.BMP

Or type the path and filename directly into the File Name: box. Then click on
 or press <ENTER> to open and display the image.

This will initiate the process of displaying the image file called EIRE4.BMP. If you make a mistake
typing in the filename the program will not be able to find the file: it will tell you so, and let you try
again.  When a suitable image document filename has been entered, a dialog box showing the image size
appears (see next page). This dialog box can also be used to alter how it is displayed.
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The Extract dialog box firstly gives the
X and Y coordinates of the First pixel
of the image (top left) and secondly
those which define the bottom right
boundary enclosing the image (in the
Last: coordinate boxes). In the case of
EIRE4.BMP which is 512 pixels
(columns) wide and 256 pixels (rows)
long, the first pixel (top left hand
corner) has coordinates (0, 0) and the
last image pixel has coordinates (511,

255). The values displayed initially are the default for that file i.e. its actual size. (They can be changed
if required, but in this case should not be changed.) Unless the file you are looking at is very large you
will normally wish to display all pixels. In this case Sample will be set to 1 for both x-axis (columns)
and y-axis (rows), as in the default for EIRE4.BMP. If Sample is set to 2 for the x-axis (columns),
then every other pixel on each line is displayed. If Sample is set to 2 for the y-axis (rows) then every
other row of pixels will be displayed. For now, leave the settings as they are and click on 
or press <ENTER> to load the image.

A window with the title EIRE4.BMP which contains the image will now appear in the top left of the
UNESCO BILKO workspace.

Note: i) that the image is displayed in shades of grey and has a grey scale with 255 brightness levels
(ranging from black to white) displayed beneath it,

ii) that the image is rather dark and lacking in contrast with the full range of brightnesses
available not being used.

iii) that the menu bar has changed with four new menus (Edit, Image, Stretch and Window)
appearing.

Activity: Before studying the image more, we will briefly explore what
happens when you subsample an image using the Extract
dialog box. Click on the control box at the top left of the EIRE4.BMP image window (see
above right) and then click on Close. Now go through the process of opening
EIRE4.BMP again but this time set Sample to 3 for both columns (X) and rows (Y) of
pixels. This means that only every third pixel in each row and only every third row of
pixels will be displayed. Not surprisingly the image you see is a third the linear size of the
one you originally displayed. Close this image window and then reload EIRE4.BMP with
the default settings so that all pixels are displayed.

Orientate yourself on the image with reference to Figure 1. The image was obtained by the Advanced
Very High Resolution Radiometer (AVHRR) sensor on a US National Oceanographic and Atmospheric
Administration (NOAA) satellite which is in a 1500 km high near-polar sun-synchronous orbit. The
spatial resolution of the sensor is 1.1 km so each pixel represents a ground area of 1.21 km². The
EIRE4 image is derived from Band 4 of the AVHRR sensor which senses electromagnetic radiation in
the wavelengths 10.50-11.50 µm which is in the thermal infra-red part of the spectrum. By convention
darker areas are warmer on AVHRR thermal images. Colder parts of the image will thus appear
brighter and warm parts dark. The image was obtained in the daytime in summer. Note that the warm
land is generally dark but the sea is brighter with the coldest (brightest) water lying north-east of Malin
Head.
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Figure 1. Map showing the area covered by the EIREn extracts of NOAA AVHRR images.

3. Using the image cursor

Activity: Look at the bottom right hand corner of the UNESCO
BILKO workspace Status Bar and note the five grey
panels, the last four of which should contain zeros (see above right). The first panel shows
the zoom on the image which is currently 1:1 or 100%. The next two panels show the
column and row coordinates of the cursor which should be at the top left (0, 0) of the
image. The last two panels show firstly, the underlying brightness value of the pixel where
the cursor is and secondly, the display value (on a scale of 0-255) which may be different
due to image processing.

Now move the mouse pointer over the image and click the
left hand button. The white arrow places a flashing cursor

in the form of a cross (+) on the image where it is clicked. The last four grey panels will
now contain the x-coordinate (column), y-coordinate (row) and underlying and display
brightness values of the pixel which the cursor is on. If the cursor was on a pixel 90 from
the left and 135 rows down the panels would look as follows. [Since no image processing
has yet been carried out the underlying data values and display values of the pixels will be
the same].

This indicates that the pixel with (x, y) coordinates (90, 135) which is in the relatively cold water north-
east of Malin Head has a brightness value (or Digital Number – DN) of 174 and is displayed on your
monitor as a grey-tone of brightness 174 (on a scale ranging from black (0) to white (255)). This is one
of the brightest pixels in the image and yet has a brightness much less than the maximum DN of 255,
which explains why the image as a whole appears rather dark.

Note: You can move the cursor around the image using the arrow keys (↑ ↓ → ← ) on the keyboard.
By default (see Edit, GoTo to alter increments), each press of an arrow moves the cursor 10 pixels in
the direction indicated until it is within 10 pixels of the edge of the image. To move the cursor one pixel
at a time hold down the <CTRL> key and then press the appropriate arrow key. You can also use Edit,
GoTo to go to a specific column and row coordinate on the image, e.g. 90, 135.

Activity: Experiment with using the cursor and then use it to find answers to the following questions.
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Question 2: Move the cursor around in a) the sea, b) the large inland lough (=lake) in Northern Ireland
(Lough Neagh - see Figure 1), and c) the land areas and make a note of the range of pixel
brightnesses for these different parts of the image.

2.1: What are the minimum and maximum pixel brightnesses (DN values) in areas which are
clearly sea?

2.2: What are the minimum and maximum pixel brightnesses (DN values) in areas which are
clearly lake/lough?

2.3: What are the minimum and maximum pixel brightnesses (DN values) in areas which are
clearly land?

Most sensors record the electromagnetic radiation reflected or emitted from the Earth’s surface in
several wavebands. Bilko for Windows allows you to view images in several wavebands simultaneously
in separate windows. Use File, Open to open EIRE2.BMP, a second image document of the same area
but taken in Band 2 of AVHRR which senses electromagnetic radiation in the wavelengths
0.72-1.10 µm which is in the near infra-red part of the spectrum. The sea absorbs near-IR radiation and
thus appears black whilst it is strongly reflected by the vegetation on land. Thus on land, lowland areas
with more luxuriant vegetation cover will tend to appear brightest and highland areas with less
vegetation will appear darker.

When you display several images you can arrange them in the workspace
using the Window menu. This is particularly useful when you wish to
display four or more images at once but try it out now.

Activity: Experiment with using Tile Horizontal and Tile Vertical
options of the Window menu (left) to arrange the two images
EIRE4 and EIRE2 in the workspace. Note that the active
image window (the one you last clicked on) becomes the left
image if you tile vertically and the top image if you tile
horizontally.

When finished, click the minimize button of the
EIRE2 image to park it at the bottom left of the
UNESCO BILKO workspace where it should
look like the icon to the right (in Windows 3.1).
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Answers to Questions - Part 1
Question 1

1.1 Top left hand corner of the image at coordinates (0, 0).

1.2 Contrast enhancement of the image data.

1.3 Frequency information relating to image pixel values in the region of the image 
currently selected. It is represented as a graph of frequencies of each pixel brightness value.

Question 2

2.1 Pixel brightnesses vary between about 100 and 177 in the sea areas.

2.2 Pixel brightnesses vary between 89 and 128 in the large lake (Lough Neagh).

2.3 Pixel brightnesses on land vary between 0 and about 62.


